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	عنوان البرنامج
	الجديد في بيئة Adobe Animate CC
	عنوان ورقة العمل الثالثة
	مساحة العمل وسير العمل في برنامج
	    Adobe Animate CC
	 تقنية المعلومات
	  Computer.2007@moe.om
	الجنس : 
	 ذكر 
	 أنثى
	المستوى التعليمي  : جامعي فما فوق
	المواد التدريبية المستخدمة : كمبيوتر – برامج (Adobe Animate CC)
	الخاتمة
	              تطوير مهاراتك في مساحة العمل وسير العمل في برنامج Adobe Animate CC .              
	 في نهاية هذه الكتاب ستكون قادر على :
	- التعرف على مكتبات Creative Cloud .
	- استخدام مكتبات Creative Cloud في البرنامج .
	- مشاركة المكتبة library والأصول  assetsمع الأخرين .
	- استخدام بيئة العمل Workspaces في البرنامج لإنتاج المحتويات الإلكترونية .
	- التعرف على الإعدادات الأساسية لمنطقة العمل Workspaces في البرنامج .
	- تنسيق وتهيئة بيئة العمل Workspacesالمناسبة للعمل .
	- حفظ مساحة العمل Workspaces في البرنامج .
	- التعرف على خيارات محرر التعليمات البرمجية في البرنامج .
	- استخدام المخطط الزمني Timeline في البرنامج  .
	- تغيير مظهر المخطط الزمني Timeline.
	- التعرف على الجداول الزمنية وتأثرها بالبرمجة النصية Action Script .
	أوفت أدوبي اليوم بوعدها عندما قررت إطلاق Animate CC رسمياً للمصممين ، المطورين وصانعي الرسوم المتحركة كبديل لتطبيق Flash Professional الذي جذب على مدى سنوات كبار المصممين لصنع صفحات الويب المتحركة ، الألعاب ، التطبيقات وغيرها.
	ووصفت الشركة هذا الإصدار الأول لبرنامج Animate CC بأنه واحد من أضخم إصدارات الشركة على الإطلاق حيث ستقدم من خلاله بتسليط الضوء على العديد من المميزات الجديدة مثل دعم المكتبات السحابية الإبداعية Creative Cloud ، خدمة Adobe Stock أو سوق بيع وشراء الصور والألعاب إلى جانب دعم موسع لكل من خدمة Typekit و SVG.
	إلى جانب إطلاق Animate، قامت أدوبي بتحديث برنامج صنع مواقع الويب بأقل الأكواد Muse CC مع إضافة دعم التصميم المرن الذي يسمح له الظهور بشكله الصحيح على الأجهزة مهما كان حجمها.
	- حول مكتبات Creative Cloud
	تعمل مكتبات Creative Cloud على جعل مواد العرض متاحة لك في أي مكان . يمكنك إنشاء الصور والألوان وتأثيرات الألوان والفرش والأشكال والمزيد في تطبيقات فوتوشوب Photoshop و Illustrator وتطبيقات الجوال mobile apps مثل Adobe Capture CC ومن ثم الدخول إليها بسهولة عبر تطبيقات سطح المكتب والجوال الأخرى من أجل سير العمل الإبداعي.
	Animate CC (formerly Flash Professional CC) يأتي متكاملة مع Libraries CC.
	 libraries CC تساعدك على تتبع جميع أصول التصميم الخاص بك. عند إنشاء أصول الرسم وحفظها إلى المكتبات، فهي متاحة للاستخدام في المستندات "Animate" الخاص بك. تتم مزامنة مواد التصميم تلقائياً، ويمكن مشاركتها مع أي شخص لديه حساب Creative Cloud. بما أن فريقك الإبداعي يعمل عبر تطبيقات أدوبي لسطح المكتب وتطبيقات الجوال، فإن أصول المكتبة المشتركة تكون دائماً محدثة وجاهزة للاستخدام في أي مكان. ويدعم هذا التحديث قبل الإصدار خيارات الاستيراد من المكتبات وإعادة استخدام الرسومات. 
	أنواع الأصول المدعومة ( Asset types ) في Animate هي :
	• الألوان Colours و الألوان ثيمات Colour Themes .
	• فرش Brushes .
	•الرسومات Graphics .
	• فرش فكتر Vector Brushes .
	استخدم الألوان والفرش والأشكال التي تم انشاؤها باستخدام تطبيقات الجوال في المستند Animate.
	يمكنك استخدام أصول الرسومات والتصميم التي تم إنشاؤها باستخدام تطبيقات أدوبي للجوال مثل Adobe Capture CC في المستند Animate باستخدام مكتبات ( libraries CC) الجديدة . يمكنك حفظ ومشاركة الألوان وتأثيرات الملونة والأشكال والفرش مع الأخرين من خلال مكتبات CC بحيث يمكنك استخدامها في أي التطبيق أدوبي الأخرى التي تدعم مكتبات CC، مثل Animate .
	 (Adobe Capture CC) هو تطبيق للموبيل المحمول (Adobe mobile) الذي يسمح لك :
	• إنشاء فرش مخصصة من الصور التي التقطت على iPhone, iPad , Android الخاص بك والبدء في استخدامها على الفور في " Adobe Animate" . لاستخدام الفرش التي أعدت باستخدام برنامج خاص بتصميم الفرش ، يجب تخزينها في مكتبة "Library CC" الخاص بك أولاً .
	• إلتقاط الأشكال مع اي فون الخاص بك  iPhone ، آي باد iPad أو أجهزة الروبوت  Androidوتحويلها إلى فكتر vectors يمكنك استخدامها في التصميمات الخاصة بك يمكنك حفظها في مكتبات " Creative Cloud Libraries" للوصول السريع إلى تطبيقات أدوبي ومشاركة المكتبات مع فريقك الإبداعي Creative Team .
	• إلتقاط تراكيب الألوان التي اخترتها باستخدام آي فون الخاص بك أو آي باد أو أجهزة الروبوت. يتم حفظ مظاهر الألوان تلقائياً في مكتبات " Creative Cloud Libraries" للدخول إلى تطبيقات سطح المكتب والجوال ، أو لمشاركتها مع فريقك .
	- استخدام مكتبات Creative Cloud :
	تسرد لوحة Creative Cloud Library في قائمة Animate CC لجميع مواد التصميمات التي خزنتها في مكتباتك إلى جانب مواد العرض التي شاركها الآخرون معك.
	- يوضح الرسم التوضيحي التالي لوحة Library CC بالتفصيل:
	 A مجلد مكتبة Library folder CC.
	B عرض العناصر كرموز.
	C عرض العناصر كقائمة.
	D البحث عن الصور.
	E لوحة تحريك قائمة محتوى المكتبة.
	F إضافة عنصر للقائمة .
	G مزامنة وتحديث المكتبة .
	H حذف عنصر في المكتبة .
	- لاستخدام مكتبات  libraries CC :
	1- انقر فوق نافذة Window >  libraries CC لتشغيل لوحة  libraries CC . 
	يمكنك رؤية جميع الأصول التي قمت بحفظها في مكتبة  libraries CC .
	2- يمكنك القيام بما يلي :
	• سحب وإسقاط "Drag-and-drop"الأصول من المكتبة إلى واجهة العمل stage .
	• انقر على موضوع اللون لتطبيق السمة على كائن على خشبة المسرح .
	• انقر على الفرشاة "vector brush" في المكتبة لاستخدامها على خشبة المسرح .
	- موقع أصول مكتبة " libraries CC" على سطح المكتب :
	تتم مزامنة مواد عرض السحاب الإبداعية creative cloud مع دليل على سطح المكتب . على سبيل المثال، في ويندوزWindows، يمكن أن يكون الموقع " C:\Users\<username>\Creative Cloud Files"
	 - إنشاء مكتبة " Library CC" جديدة :
	يمكنك إنشاء مكتبة جديدة لتخزين مواد العرض الإبداعية على الإنترنت online. وفي المكتبة يمكن تخزين ما يصل إلى 1000 عنصر وليس هناك حد لعدد المكتبات التي يمكنك إنشاءها . يتم تخزين الأصول التي تخزنها في المكتبة محلياً، ولكن تتم مزامنتها مع Creative Cloud.
	- مشاركة المكتبة والأصول Sharing your library and assets :
	يمكنك التعاون مع مستخدمين آخرين ومشاركة مجلد أو مكتبة من حساب Creative Cloud مع مستخدمي " Creative Cloud users" المحددين. ويمكن لجميع المستخدمين المدعوين للعمل بشكل تعاوني باستخدام أصول من المجلد المشترك أو المكتبة . ويمكن للمتعاونين عرض محتويات المجلد المشترك أو المكتبة المشتركة أو تعديلها أو إعادة تسميتها أو نقلها أو حذفها. 
	لمشاركة الروابط العامة مع الملفات والمجلدات مع الآخرين (مشاركة الأصول مع حق الوصول للقراءة فقط)، راجع مشاركة الملفات والمجلدات من هنا .
	لمزيد من المعلومات حول المكتبات libraries فيCreative Cloud ، راجع Creative Cloud libraries من هنا.
	- حول مخزن أدوبي " Adobe Stock"
	للحصول على إرشادات تفصيلية حول كيفية استخدام Adobe Stock ، يرجى الرجوع إلى صفحة مساعدة Adobe Stock على https://helpx.adobe.com/stock/help/using-adobe-stock.html. ملاحظة: Adobe Stock متوفر فقط في البلدان التالية: الولايات المتحدة وكندا والمكسيك والمملكة المتحدة وإيرلندا وجنوب أفريقيا ونيوزيلندا وأستراليا واليابان وهولندا والنرويج والسويد والدنمارك وبلجيكا وسويسرا وفنلندا ولوكسمبورغ وألمانيا وفرنسا وإيطاليا والنمسا وإسبانيا والبرتغال واليونان وبولندا والجمهورية التشيكية وبلغاريا وأستونيا ولاتفيا وليتوانيا وهنغاريا ومالطة ورومانيا وسلوفينيا وسلوفاكيا وقبرص. 
	- استخدام Adobe Stock في Animate CC :
	باستخدام خيار بحث Adobe Stock في لوحة Library CC ، يمكنك البحث عن الصور في Adobe Stock، ومعاينة الصورة في مكتبتك، وشراء الصورة، ثم إضافتها إلى المستند. الصور التي تضيفها إلى المسرح يمكن بعد ذلك أن تكون متحركة " animated".
	البحث عن الصور واستيرادها من Adobe Stock
	1 انقر فوق ويندوز Windows >  libraries CC. ثم أكتب Adobe Stock في مربع البحث.
	1- نظرة عامة على شاشة الترحيب Welcome screen :
	عندما يتم تشغيل Animate CC (سابقا فلاش Flash Professional CC)  Animate CC بدون فتح أية مستندات ، تظهر شاشة الترحيب . 
	* تحتوي شاشة الترحيب على المجالات الأربعة التالية كما في الصورة التالية يرافقها الشرح :
	/
	A- فتح ملف حديث تم إنشاءوه من قبل Open a Recent Item : يتيح لك فتح أحدث مستنداتك (انقر عليه لفتحه).
	B- إنشاء ملف جديد Create New :  ملف ActionScript أو أي ملف من مستندات البرنامج Animate        documents.
	C- إنشاء ملف من قالب جاهز Create from Template : استرداد قالب من القوالب الجاهزة .
	D- Adobe Exchange : رابط إلى موقع " Animate Exchange website" ، حيث يمكنك تنزيل تطبيقات المساعدة والإضافات والمعلومات ذات الصلة بالبرنامج.
	E-كما توفر شاشة الترحيب إمكانية الوصول السريع إلى موارد المساعدة " Help resources". 
	F- يمكنك القيام بجولة في Animate ، والتعرف على موارد الوثائق والشروحات والمعلومات المرتبطة بالبرنامج ، والعثور على مرافق التدريب المعتمدة من قبل شركة أدوبي .
	G- لإخفاء شاشة الترحيب ، حدد عدم إظهارها مرة أخرى.
	• لعرض شاشة الترحيب، حدد Edit > Preferences لنظام الويندوز (Windows®) و في الماك (Macintosh®) حددAnimate ثم Preferences ثم حدد على خيار شاشة الترحيب " Welcome Screen".
	2- استخدام منطقة العملStage  :
	منطقة العمل هي منطقة مستطيلة حيث يمكنك وضع المحتوى الرسومي عند إنشاء مستند في البرنامج . تمثل منطقة العمل في بيئة التأليف المساحة المستطيلة في Flash Player " Flash Player" أو في نافذة متصفح الويب" web browser window " حيث يظهر المستند أثناء التشغيل . 
	A - تكبير منطقة العمل Zoom the stage :
	لعرض المرحلة بأكملها على الشاشة ، أو لعرض منطقة معينة من الرسم الخاص بك عن طريق عدسة التكبير ، وتغيير مستوى التكبير. يعتمد التكبير الأقصى على دقة الشاشة وحجم المستند . الحد الأدنى لقيمة التكبير على المسرح هو 8٪. الحد الأقصى لقيمة التكبير في المرحلة هو 2000٪.
	B - نقل ودوران منطقة العمل Move the view of the Stage :
	عندما يتم تكبير منطقة العمل ، قد لا تكون قادراً على رؤية كل منطقة العمل . لتغيير وجهة النظر دون الحاجة إلى تغيير التكبير، استخدم أداة اليد لتحريك منطقة العمل .
	ملاحظة: يمكنك أيضا استخدام إيماءات اللمس المتعدد في الأجهزة المتوافقة.
	• في لوحة Tools panel (أدوات)، قم بتحديد أداة Hand tool واسحب منطقة العمل إلى المنطقة التي تريدها .
	• قم بتحديد أداة التدويرRotation Tool ، ستظهر النقطة المحورية للتدوير على الشاشة ، ويشار إليها بواسطة التقاطع .
	 يمكنك تغيير موضع النقطة المحورية بالنقر على الموضع المطلوب الذي تريده .
	- مساحة العمل workflow :
	لإنشاء تطبيق   Animate CC، تقوم عادة بتنفيذ الخطوات الأساسية التالية :
	- تخطيط التطبيق Plan the application :
	حدد المهام الأساسية التي سيؤديها التطبيق.
	- إضافة عناصر الوسائط Add media elements :
	إنشاء عناصر الوسائط واستيرادها، مثل الصور والفيديو والصوت والنصوص.
	- ترتيب العناصر Arrange the elements :
	ترتيب عناصر الوسائط على منطقة العمل وفي الجدول الزمني لتحديد متى وكيف تظهر في التطبيق الخاص بك.
	- تطبيق المؤثرات الخاصة Apply special effects : 
	تطبيق المرشحات الرسومية فلاتر graphic filters (مثل blurs, glows, and bevels) والمؤثرات الخاصة الأخرى كما تراه مناسباً .
	- استخدم ActionScript للتحكم في الحركة :
	اكتب رمز ActionScript ® للتحكم في كيفية تصرف عناصر الوسائط ، بما في ذلك كيفية استجابة العناصر لتفاعلات المستخدم .
	- اختبار Test ونشر publish التطبيق الخاص بك :
	اختبر ملف FLA الخاص بك (Control > Test Movie) 
	للتحقق من أن التطبيق يعمل كما ترغب والإصلاح أي أخطاء واجهتك. يجب اختبار التطبيق طوال عملية الإنشاء . 
	قم بنشر ملف FLA الخاص بك (ملف File > نشر  Publish) كملف swf الذي يمكن عرضه في صفحة ويب وتشغيله مع Flash Player Flash® Player.
	اعتماداً على مشروعك وأسلوب عملك ، يمكنك استخدام هذه الخطوات بترتيب مختلف .
	- نظرة عامة على مساحة العمل Workspace :
	يمكنك إنشاء مستنداتك وملفاتك ومعالجتها باستخدام عناصر مختلفة ، مثل اللوحات panels والحانات bars والنوافذ  windowsويسمى أي ترتيب لهذه العناصر مساحة العمل workspace .
	تتشارك مساحات عمل التطبيقات المختلفة في Adobe® وفي Creative Suite® في نفس واجهة العمل بحيث يمكنك التنقل بين التطبيقات بسهولة . يمكنك أيضا التكيف مع كل تطبيق بالطريقة التي تعمل بها من خلال اختيار عدة مساحات عمل محددة مسبقاً أو عن طريق إنشاء عمل خاص بك.
	على الرغم من أن تخطيط مساحة العمل الافتراضي يختلف في منتجات مختلفة ، يمكنك التعامل مع العناصر بنفس الطريقة كما في الصورة رقم (3) .
	A- نافذة المستندات المفتوحة حالياً : 
	-B شريط التطبيق (شريط القوائم ) : يحتوي شريط التطبيق Application bar في الجزء العلوي على مبدل نوع مساحة العمل والقوائم (ويندوز فقط) ، وبعض عناصر التحكم .
	C- مبدل وعنوان اسم لوحة العمل Workspace.
	D- لوحة أدوات  Tools panel: يحتوي على أدوات لإنشاء وتحرير الصور، والأعمال الفنية، وعناصر الصفحة ، وما إلى ذلك. 
	E- Property : تعرض لوحة الخصائص خصائص العنصر وخيارات للأداة المحددة حالياً . 
	F - شريط عنوان اللوحات المفتوحة .
	-G يظهر الأوامر المرتبطة باللوحة المفتوحة حالياً.
	- حفظ وتبديل مساحات العمل    Save and switch workspaces:
	من خلال حفظ لوحة العمل الحالية كمساحة عمل ، يمكنك استعادة مساحة العمل حتى إذا قمت بنقل أو إغلاق لوحة معينة . وتستطيع تنسق مساحة عمل خاصة بك بنقل وسحب وترتيب لوحات البرنامج على حسب رغبتك .
	تظهر أسماء مساحات العمل المحفوظة في مبدل مساحة العمل في الشريط التطبيق كما في الصورة رقم 3 لحرف C.
	- حفظ مساحة عمل مخصصة Save a custom workspace :
	لحفظ مساحة العمل في التكوين الذي تريد حفظه ، قم بأحد الإجراءات التالية :
	اختر مساحة عمل جديدة New Workspace من مبدل مساحة العمل  workspace switcher في شريط التطبيق Application bar .
	كما في صورة التالية :
	/
	1- اكتب اسماً لمساحة العمل New Workspace.
	2- من القائمة الظاهرة في شريط التطبيق يمكنك عرض أو تبديل نوع مساحة العمل على حسب رغبتك .
	1- حذف مساحة عمل مخصصة : 
	حدد إدارة مساحات العمل من مبدل مساحة العمل في شريط التطبيق ، وحدد مساحة العمل ، ثم انقر فوق حذف . 
	 تعيين الخيارات وتفضيلات preferences لمساحة العمل :
	يمكنك تعيين الخيارات preferences لعمليات التطبيق العامة general application operations ، وعمليات التحرير editing operations ، والشفرات code وعمليات المترجم ، إعدادات المزامنة settings sync ، وخيارات الرسم drawing والنص .
	1- حدد تحرير Edit >Preferences  .
	يمكنك تعيين الخيارات "تفضيلات" لعمليات التطبيق العامة General ، وعمليات التحرير editing operations ، والشفرات وعمليات المترجم compiler ، إعدادات المزامنة sync settings ، وخيارات الرسم drawing والنص text .
	* تعيين الخيارات العامة Set General preferences :
	A- التراجع عن المستند أو الكائن .
	Document- or Object-level undo  يحفظ التراجع على مستوى المستند بقائمة واحدة بجميع الإجراءات الخاصة بك في وثيقة Animate بأكملها .
	يحتفظ التراجع على مستوى الكائن Object-level undo بقوائم منفصلة من الإجراءات الخاصة بك لكل كائن في المستند. ويتيح لك التراجع عن إجراء كائن واحد دون الحاجة إلى التراجع عن الإجراءات على الكائنات الأخرى التي ربما تم تعديلها مؤخراً .
	تراجع عن المستويات لتعيين عدد مستويات التراجع أو الإعادة ، أدخل قيمة من 2 إلى 300. مستويات التراجع تتطلب وجود الذاكرة ؛ والمزيد من مستويات التراجع التي تستخدمها ، يتم استهلاك المزيد من ذاكرة النظام . العدد الافتراضي هو 100.
	B- استرداد والحفظ التلقائي Auto-Recovery.
	عند تمكين (الإعداد الافتراضي)، يحفظ هذا الإعداد نسخة من كل ملف مفتوح في الفاصل الزمني المحدد، في نفس المجلد مثل النسخ الأصلية . إذا لم تقم بحفظ الملف بعد ، يحفظ Animate النسخ في مجلد " Temp folder". 
	أسماء الملفات هي نفس الأسماء الأصلية، مع إضافة "RECOVER_" إلى بداية اسم الملف . إذا تم إنهاء "برنامج Animate فجأه" بشكل غير متوقع ، يظهر مربع حوار عند إعادة التشغيل للسماح لك بفتح ملف استرداد تلقائي auto-recover . عند الخروج Animate عادة ، يتم حذف ملفات استرداد تلقائي " auto-recover".
	C- واجهة المستخدم User Interface : حدد نمط واجهة المستخدم المفضلة لديك، بين الظلام Dark أو الضوء Light. لتطبيق التظليل على عناصر واجهة المستخدم ، حدد تمكين التظليل Enable Shading. وتستطيع إخفاء أطار خلفية العمل .
	D- مساحة العمل Workspace: لوضع لوحة في وضع الرمز تلقائياً عند النقر فوقها ، حددAuto-Collapse Icon Panels رمز تلقائي . لفتح نافذة منفصلة عند تحديد Control > Test ، حدد فتح المستندات المتحركة والبرنامج النصي في ويندوز منفصلة . 
	الافتراضي هو فتح نافذة منفصلة عند اختبار وتجربة العمل the test في إطار خاص .
	E- Highlight Color تسليط الضوء على اللون لاستخدامه كمخطط الطبقة الحالية أو بتحدد لوناً من اللوحة لكل جزء أو كائن .
	F- تم شرحها بالتفصيل في الورقة الأولى ويقصد بها تحديد التدرج للألوان طبقات الجسم لتوضيح الحركة من البداية للنهاية .
	*تعيين إعدادات المزامنة Sync Settings :
	في علامة التبويب إعدادات المزامنة كما في الصورة رقم (7) ، يمكنك تحديد إعدادات مزامنة في Animate مع حساب Creative Cloud و المكتبات .
	في علامة التبويب إعدادات المزامنة ، يمكنك تحديد إعدادات مزامنة Animate مع حساب Creative Cloud والمكتبات.
	A- الرقم التعريفي لادوبي Adobe ID
	يعرض هذا المعرف الذي سجلت الدخول إليه في حساب Creative Cloud والتاريخ والوقت الذي تمت فيه آخر عملية مزامنة مع حساب Creative Cloud.
	• لعرض ملف تعريف Creative Cloud والمكتبة ، أو لتسجيل الدخول باستخدام معرف أدوبي مختلف ، انقر فوق Manage Account .
	• لمزامنة الإعدادات، انقر فوق إعدادات المزامنة الآن Sync Settings Now .
	B- خيارات المزامنة Sync Options :
	يعرض هذا خيارات المزامنة التي قمت بتعيينها بين Animate وحساب Creative Cloud الخاص بك. يمكنك مزامنة خيارات وتفضيلات preferences التطبيق الخاص بك ومساحات العمل  workspaces. 
	وإعدادات المستند الإفتراضي default document settings واختصارات لوحة المفاتيح  keyboard shortcuts؛ 
	والشبكة grid ، وأدلة guides، وإعدادات snapping settings . 
	وإعدادات ورقة sprite sheet settings ؛ وملامح العرض المتغير  variable width profiles، 
	والفرش المخصصة custom brushes و فرش التلوين Paint brushes .
	• مزامنة : 
	تعيين خيارات المزامنة عن طريق الاختيار بين:
	- الكل (مزامنة كافة الإعدادات)
	- مخصص (مزامنة الإعدادات التي قمت بتحديدها من الخيارات المعروضة أدناه)
	- تعطيل (تعطيل كافة المزامنة).
	*تعيين خيارات محرر التعليمات البرمجية Code Editor preferences :
	في علامة التبويب "محرر التعليمات البرمجية  Code Editor tab"، يمكنك تعيين الطريقة التي تريد أن يتم عرض التعليمات البرمجية في Animate.
	كما في الصورة رقم (8).
	A- ضمن خيارات التحرير Editing Options ، يمكنك تغيير الإعدادات الافتراضية لما يلي :
	• الخط Font : تعيين نوع الخط وحجمه .
	• نمط  Style: اختر بين العادية  regular، مائل  italic، سميك bold، أو مائل وسميك bold italic.
	• تعديل تلوين النص Modify Text Coloring : انقر على هذا الزر لتعيين لون النص للمقدمة والخلفية والكلمات الرئيسية والتعليقات والمعرفات والسلاسل.
	• هدف تلقائي للشفرة Automatic code brace : تم تمكينها بشكل افتراضي . يتم إغلاق جميع الأقواس والرموز افتراضياً.
	• المسافة البادئة التلقائية Automatic indentation : تم تمكينها بشكل افتراضي وتستطيع إيقاف تشغيلها إذا كنت لا تريد المسافة البادئة .
	• تلميحات التعليمات البرمجية Code hints : تم تمكينها افتراضياً. قم بإلغاء تحديد مربع الاختيار إذا كنت لا تريد أن تظهر تلميحات التعليمات البرمجية أثناء كتابة التعليمات البرمجية.
	• ملفات ذاكرة التخزين المؤقت Cache Files : تعيين الحد لملفات ذاكرة التخزين المؤقت . الافتراضي هو 800.
	• حجم علامة التبويب Tab size : يتم تعيين الحجم الافتراضي لعلامة التبويب التعليمات البرمجية إلى 4. 
	ادخل أي قيمة إذا كنت ترغب في تغيير حجمه .
	B- ضمن تنسيق كود Format Code :
	 يمكنك تعيين الخيارات التالية والتحقق من جزء المعاينة لكيفية تطبيق التغيير على التعليمات البرمجية Code :
	• لغة النص البرمجي Script Language : نحدد لغة النص البرمجي الافتراضية  ActionScript أو JavaScript ويتم عرض نموذج التعليمات البرمجية أثناء تحديد أحد الخيارات .
	• نمط الدعامة Brace style : حدد نمط هدفك المفضل ، إما في نفس سطر عبارات التحكم ، أو في سطر منفصل ، أو فقط بين الأقواس النهائية في سطر منفصل .
	• أساليب الفصل  Break chained methods : نحدد خطوط أو رمز للفصل تلقائياً .
	• حافظ على المسافة البادئة للمصفوفة Keep array indentation : نحدد لإبقاء الصفوف مباعدة بشكل منطقي.
	• الحفاظ على مساحة بعد الكلمات الرئيسية Keep space after keywords : تم تحديده افتراضياً تغييره إذا كنت لا تريد مسافة بعد كل كلمة رئيسية .
	* تعيين خيارات الملفات النصية : Set Script Files preferences  
	كما في الصورة التالية رقم (9)
	تسمح لك علامة التبويب ملفات Script Files بتعيين خيارات الاستيراد لملفات البرنامج النصي :
	- فتح Open : حدد ترميز الذي تريده 
	 UTF-8 Encoding لفتح أو استيراد باستخدامUnicode       encoding أو حدد ترميز افتراضي لفتح أو استيراد باستخدام نموذج ترميز اللغة المستخدمة حالياً من قبل النظام الخاص بك .
	- إعادة تحميل الملفات المعدلة Reload modified files :
	 لتحديد ما يحدث عند تعديل ملف نصي أو نقله أو حذفه . حدد دائماً ، أبداً ، أو مطالبة .
	• دائماً Always : لا يتم عرض تحذير ، ويتم إعادة تحميل الملف تلقائياً .
	• أبدا Never : لا یتم عرض أي إنذار ، ویظل الملف في حاله .
	• مطالبة Prompt (افتراضي) : يتم عرض تحذير ، ويمكنك اختيار ما إذا كنت تريد إعادة تحميل الملف أو لا .
	عند إنشاء تطبيقات مع البرامج النصية الخارجية ، يساعدك هذا التفضيل على تجنب الكتابة فوق نص برمجي تم تعديله من قبل عضو الفريق منذ فتح التطبيق ، أو تجنب نشر التطبيق مع الإصدارات القديمة من البرامج النصية . تسمح لك التحذيرات بإغلاق النص البرمجي تلقائياً وإعادة فتح أحدث إصدار معدلة .
	محرر الفصل Class editor : حدد المحرر لفئات التحرير editing classes. الخيارات هي :
	 Animate , Flash Builder, or Ask.
	*تعيين خيارات Compiler :
	تسمح لك علامة التبويب Compiler في مربع الحوار preferences بتعيين خيارات المترجم التالية للغة التي حددتها. يمكنك التصفح إلى مسار أو ملف SWC أو تحديد مسار جديد:
	• مسار  SDK: المسار إلى المجلد الذي يحتوي على bin ، frameworks ، lib ، والمجلدات الأخرى. 
	• مسار المصدر Source : المسار الذي يشير إلى المجلدات التي تحتوي على ملفات فئة ActionScript.
	• مسار المكتبة Library: المسار الذي يشير إلى ملفات SWC أو المجلدات التي تحتوي على ملفات SWC.
	• مسار المكتبة الخارجية External library: المسار الذي يشير إلى ملفات SWC المستخدمة كمكتبات مشتركة للتشغيل .
	* تعيين خيارات النص Text :
	يمكنك تحديد الخيارات التالية للنص كما في الصورة رقم (11): 
	• Default Mapping Font  : تعيين الخط الافتراضي .
	• Style : نمط الخط .
	• Show Font Names in English  :إظهار اسم الخط في لغة انجليزية .
	•  : Show Font Previewعرض معاينة الخط .
	• Font Preview Size : حجم معاينة الخط .
	*تعيين خيارات الرسم Drawing : 
	يتيح لك تعيين خيارات الرسم كما في الصورة رقم 12:
	لأداة القلم Pen tool : حدد معاينة القلم لعرض خط المعاينة من آخر نقطة تم النقر عليها إلى الموقع الحالي للمؤشر. لعرض نقاط التحكم كمربعات صغيرة مملوءة بدلاً من المربعات غير ظاهرة. حدد إظهار المؤشرات الدقيقة لعرض مؤشر التقاطع بدلاً من رمز أداة القلم عند استخدام أداة القلم . يتيح لك هذا الخيار الاطلاع على الهدف المحدد للنقرات بسهولة أكبر.
	IK Bone Tool : يتم تحديد تحويل نقطة التحول افتراضياً لأداة العظام Bone .
	خطوط الاتصال Connect lines : يحدد مدى قرب نهاية السطر الذي يتم رسمه يجب أن يكون إلى جزء سطر موجود قبل أن يستقر نقطة النهاية إلى أقرب نقطة على السطر الآخر. ويتحكم هذا الإعداد أيضا في التعرف على الخط الأفقي والرأسي - أي كيف يجب رسم خط أفقي أو رأسي تقريباً قبل أن يجعل Animate أفقياً أو رأسياً تماماً. عند تشغيل الأداة "Snap To Objects "، يتحكم هذا الإعداد في كيفية اقتراب الأجسام القريبة من بعضها البعض.
	منحنيات ناعمة Smooth curves : تحدد مقدار التنعيم المطبق على الخطوط المنحنية المرسومة باستخدام أداة القلم الرصاص عند ضبط وضع الرسم على Straighten or Smooth. 
	*ملاحظة : لتزيد من نعومه القطاعات المنحنية الموجودة ، استخدم تعديل  Modify > الشكل  Shape> نعومه وتعديل  Smooth and Modify> الشكل  Shape> تحسين  Optimize.
	التعرف على خطوط Recognize lines : يحدد نوع قطعة خط رسمها مع أداة قلم رصاص يجب أن يكون قبل Animate يتعرف بها كخط مستقيم . إذا تم إيقاف التعرف على خطوط أثناء رسم ، استقامة خطوط في وقت لاحق عن طريق تحديد واحد أو أكثر من شرائح خط وتحديد تعديل  Modify> الشكل  Shape> تعديل Straighten .
	التعرف على الأشكال Recognize shapes : يتحكم بدقة في رسم الدوائر، البيضاوي، المربعات، المستطيلات، ورسم  90 درجة أو 180 ° أقواس بالنسبة لهم ليتم الاعتراف بها كأشكال هندسية وإعادة رسم بدقة . 
	الخيارات هي Off ، Strict ، Normal ، و Tolerant. 
	يتطلب Strict أن يتم رسمها على شكل قريبة جداً من مستقيم .
	 Tolerant يحدد أن الشكل يمكن أن تكون خشنة إلى حد ما، والبرنامج Animate يعيد رسم الشكل . إذا تم التعرف على الأشكال إيقاف أثناء رسم، وتصويب خطوط في وقت لاحق عن طريق اختيار واحد أو أكثر من الأشكال (على سبيل المثال، شرائح خط متصلة).
	دقة النقر Click accuracy: لتحديد مدى قرب العنصر الذي يجب أن يكون المؤشر قد حدده .
	استعادة جميع الخيارات إلى الإعدادات الافتراضية في مربع الحوار Preferences ، انقر فوق Reset إلى الإعدادات الافتراضية أو اضغط مع الاستمرار على :
	     (Windows)  Control+Alt+Shift و (Mac OS) Command+Option+Shift 
	حول المخطط الزمني Timeline :
	*ملاحظة : عند تشغيل الرسوم المتحركة ، يتم عرض معدل الإطار الفعلي ؛ قد يختلف هذا عن إعداد معدل الإطار المستند إذا كان الكمبيوتر لا يمكن حساب وعرض الرسوم المتحركة بسرعة كافية .
	يعرض المخطط الزمني مكان حدوث الرسوم المتحركة في مستند ، بما في ذلك الرسوم المتحركة لكل إطار على حدة ، والرسوم المتحركة المزدوجة ، ومسارات الحركة .
	تتيح لك عناصر التحكم في قسم الطبقات في المخطط الزمني إخفاء الطبقات أو عرضها أو قفلها أو إلغاء قفلها بالإضافة إلى محتويات طبقة العرض كخطوط عرض . يمكنك سحب إطارات إلى موقع جديد على نفس الطبقة أو إلى طبقة مختلفة .
	- تغيير مظهر المخطط الزمني Change the appearance of the Timeline :
	بشكل افتراضي ، يظهر المخطط الزمني أسفل نافذة المستند الرئيسي . لتغيير موضعها ، قم بفصل المخطط الزمني من نافذة المستند وتعويمه في النافذة الخاصة به أو إرساله إلى أي لوحة أخرى تختارها . يمكنك أيضا إخفاء المخطط الزمني.
	لتغيير عدد الطبقات والإطارات المرئية، قم بتغيير حجم المخطط الزمني . لعرض طبقات إضافية عندما يحتوي المخطط الزمني على طبقات أكثر مما يمكن عرضه ، استخدم أشرطة التمرير على الجانب الأيسر من المخطط الزمني .
	• لنقل الجدول الزمني عند إرسائھ إلی نافذة المستند، اسحب علامة تبویب عنوان العنوان في الركن العلوي الأیمن من الجدول الزمني.
	• لإرساء جدول زمني غير معلق إلى نافذة التطبيق، اسحب علامة التبويب شريط العناوين إلى أعلى أو أسفل نافذة المستند.
	• لإرساء جدول زمني غير مقفل إلى لوحات أخرى، اسحب علامة تبويب شريط العنوان Timeline إلى الموقع الذي تختاره. لمنع الجدول الزمني من الالتحام إلى لوحات أخرى ، اضغط على Control أثناء السحب . يظهر شريط أزرق يشير إلى حيث تم تثبيته .
	• لإطالة أو اختصار حقول اسم الطبقة في لوحة Timeline، اسحب الشريط الذي يفصل بين أسماء الطبقات وأجزاء الإطارات من المخطط الزمني.
	- تغيير عرض الإطارات في المخطط الزمني :
	لعرض القائمة المنبثقة Frame ، انقر فوق عرض الإطار في الركن العلوي الأيسر من المخطط الزمني.
	حدد من الخيارات التالية:
	• لتغيير عرض خلايا الإطار، حدد صغير جداً Tiny أو صغير Small أو عادي Normal أو متوسط Medium ​​أو 
	كبير Large . (الإعداد الكبير لعرض الإطار مفيد لعرض تفاصيل الموجات الصوتية)
	• لتقليل ارتفاع الصفوف خلية الإطار أختر أمر " Short".
	• لتشغيل تلوين تسلسل الإطار أو إيقاف تشغیلھا ، حدد الإطارات ملونة Tinted Frames .
	• لعرض صور مصغرة لمحتوى كل إطار يتم تحجيمه لتتناسب مع إطارات المخطط الزمني ، حدد معاينة Preview. 
	• لعرض صور مصغرة لكل إطار كامل (بما في ذلك المساحة الفارغة) ، حدد معاينة في السياق Preview In Context. وهذا مفيد لمشاهدة طريقة تحرك العناصر في إطاراتها على مدار الرسوم المتحركة ، ولكن المعاينات عادة ما تكون أكثر من خيار المعاينة " Preview option" .
	• لتخصيص عدد الإطارات في طريقة عرض المخطط الزمني، حدد تناسب إطارات أقل في طريقة العرض Fit less frames أو تناسب المزيد من الإطارات في العرض في المخطط الزمني Fit more frames in view بجانب شريط تغيير عرض المخطط الزمني لتغيير الحجم .
	• لإعادة ضبط زووم المخطط الزمني إلى المستوى الافتراضي ، حدد إعادة تعيين زووم Reset the timeline zoom المخطط الزمني إلى المستوى الافتراضي بجوار شريط شريط التمرير . 
	- تغيير ارتفاع الطبقة في المخطط الزمني :
	- قم بأحد الإجراءات التالية:
	• انقر نقراً مزدوجاً فوق رمز الطبقة layer’s icon (الرمز الموجود على يمين اسم الطبقة) في المخطط الزمني.
	• انقر بزر الماوس الأيمن (ويندوز) أو انقر مع الضغط على Control (في نظام التشغيل Macintosh) واسم الطبقة وحدد خصائص من context menu القائمة .
	• حدد الطبقة في المخطط الزمني وحدد Modify> المخطط الزمنيTimeline> خصائص الطبقة Layer Properties .
	- في مربع الحوار "خصائص الطبقة Properties "، حدد خيارات "ارتفاع الطبقة" Layer Height ثم انقر فوق "موافق".
	- تعيين شفافية الطبقة layer transparency :
	افعل واحداً من ما يلي :
	• Shift+Click على عمود العين في المخطط الزمني لتعيين مستوى الرؤية إلى الشفافية.
	• انقر نقراً مزدوجاً فوق رمز الطبقة (الرمز الموجود على يمين اسم الطبقة) في المخطط الزمني.
	• انقر بزر الماوس الأيمن (ويندوز) أو انقر مع الضغط على Control (في نظام التشغيل Macintosh) واسم الطبقة وحدد خصائص من قائمة السياق. في مربع الحوار خصائص الطبقة، حدد Visibility> Transparent.
	• انقر بزر الماوس الأيمن (ويندوز) أو انقر مع الضغط على Control (في نظام التشغيل Macintosh) واسم الطبقة وحدد إظهار Show Others as Transparent .
	-  تغيير حجم المخطط الزمني Resize the Timeline :
	• إذا تم إرساء الجدول الزمني لنافذة التطبيق الرئيسية، اسحب الشريط الذي يفصل بين المخطط الزمني ومنطقة مساحة العمل Stage area.
	• إذا لم يتم إرساء الجدول الزمني لنافذة التطبيق الرئيسية، اسحب الزاوية اليمنى السفلى (ويندوز) أو مربع الحجم في الزاوية اليمنى السفلى (Macintosh).
	- حرك Move the playhead :
	يتحرك رأس التشغيل الأحمر في الجزء العلوي من المخطط الزمني كوثيقة تشغيل للإشارة إلى الإطار الحالي المعروض على المسرح . يعرض رأس المخطط الزمني أرقام إطارات الرسوم المتحركة . لعرض إطار على المرحلة ، حرك مؤشر إلى الإطار في المخطط الزمني. 
	لعرض إطار محدد عند العمل مع عدد كبير من الإطارات التي لا يمكن عرضها كلها في المخطط الزمني مرة واحدة، قم بتحريك مؤشر على طول المخطط الزمني.
	• للانتقال إلى إطار، انقر فوق موقع الإطار في رأس المخطط الزمني، أو اسحب رأس التشغيل إلى الموضع المطلوب.
	• لتحديد المخطط الزمني علی الإطار الحالي، انقر فوق زر إطار المركز في الجزء السفلي من المخطط الزمني.
	• مع "تكرار" في الجدول الزمني، يمكنك الآن تكرار تدفق الصوت ضمن مجموعة من الأطر جنباً إلى جنب مع الرسوم المتحركة الأخرى .
	مع ActionScript®، يمكنك التحكم في المخطط الزمني في وقت التشغيل . استخدام ActionScript يسمح لك بإنشاء التفاعل والقدرات الأخرى في ملفات FLA مع المخطط الزمني .
	- مسارات مطلقة Absolute paths :
	يبدأ المسار المطلق مع اسم المستوى الذي يتم تحميل المستند ويستمر من خلال قائمة العرض حتى يصل إلى المثال المستهدف . يمكنك أيضاً استخدام الاسم المستعار _root للإشارة إلى أعلى الجدول الزمني للمستوى الحالي . على سبيل المثال ، إجراء في  movie clip Oman التي تشير إلى Muscat  movie clip يمكن استخدام المسار المطلق  root.Oman. Muscat _ 
	يتم تحميل المستند الأول الذي يتم فتحه في Flash Player عند"المستوى 0" يجب تعيين كل مستند إضافي على رقم مستوى . عند استخدام مرجع مطلق في movie clip للإشارة إلى "loaded document" ، استخدم النموذج  levelX_حيث X هو رقم المستوى الذي يتم تحميل المستند فيه . 
	على سبيل المثال ، الوثيقة الأولى التي تفتح في Flash Player تسمى level0_
	 "loaded document" مستند محمل في المستوى 3 يسمى level3_
	للتواصل بين المستندات على مستويات مختلفة ، يجب استخدام اسم المستوى " level name"في المسار المستهدف . يوضح المثال التالي كيف ستعالج حالة مسقط Muscat الموجود في movie clip يسمى صور Sur
	 (مسقط على نفس مستوى صور وهو 5) :  level5.Sur. Muscat_
	يمكنك استخدام الاسم المستعار root_ للإشارة إلى المخطط الزمني الرئيسي للمستوى الحالي . بالنسبة إلى المخطط الزمني الرئيسي ، فإن الاسم المستعار root_ يقف على level0_ عندما يستهدفه movie clip أيضا على level0 _ في الوثيقة   level5_، _root يساوي level5_ عندما يستهدفها movie clip أيضا على مستوى 5 . على سبيل المثال ، إذا تم تحميل Oman  movie clip و Muscat  مسقط على حد سواء في نفس المستوى ، يمكن استخدام المسار المطلق التالي لاستهداف المثيل مسقط: root.Oman.Muscat _
	- المسارات النسبية Relative paths :
	يعتمد المسار النسبي على العلاقة بين المخطط الزمني والمخطط الزمني المستهدف . يمكن للمسارات النسبية معالجة الأهداف فقط ضمن مستوى الخاصة بهم من Flash Player . على سبيل المثال ، لا يمكنك استخدام مسار نسبي في إجراء على level0_ يستهدف جدول زمني على level5_.
	في مسار نسبي ، استخدم الكلمة الرئيسية هذا للإشارة إلى الجدول الزمني الحالي في المستوى الحالي ؛ استخدم الاسم المستعار parent_للإشارة إلى الجدول الزمني الأصلي للجدول الزمني الحالي . يمكنك استخدام الاسم المستعار parent_ مراراً وتكراراً لترتفع مستوى واحد في التسلسل الهرمي movie clip ضمن نفس مستوى Flash Player. على سبيل المثال ، يقوم parent._parent_ بالتحكم في movie clip حتى مستويين في التسلسل الهرمي. الجدول الزمني الأعلى على أي مستوى في Flash Player هو الجدول الزمني الوحيد مع قيمة parent _ التي غير محددة .
	إجراء في الجدول الزمني مثال مسقط ، تقع على مستوى واحد أدناه Sur ، يمكن استخدام المسار الهدف التالي لاستهداف Sur مثيل :
	parent_
	لاستهداف Muscat المثيل من إجراء في المخطط الزمني Sur ، يمكنك استخدام المسار النسبي التالي:
	parent. _parent.Muscat.Sur_
	المسارات النسبية مفيدة لإعادة استخدام البرامج النصية. على سبيل المثال ، يمكنك إرفاق النص البرمجي التالي إلى movie clip يقوم بتكبير الأصل بنسبة 150٪:
	onClipEvent (load) {
	 ;150=_parent._xscale 
	 }; parent. _yscale = 150_
	يمكنك إعادة استخدام هذا البرنامج النصي من خلال إرفاقه بأي مثيل ل movie clip.
	سواء كنت تستخدم مسار مطلق أو نسبي ، يمكنك تحديد متغير في مخطط زمني أو خاصية كائن بنقطة (.) متبوعة باسم المتغير أو الخاصية . على سبيل المثال، تعيين العبارة التالية اسم المتغير في نموذج المثيل إلى قيمة "Oman":
	;"Oman"=_root.form.name
	- استخدام المسارات المستهدفة المطلقة والنسبية   : 
	يمكنك استخدام ActionScript لإرسال رسائل من جدول زمني إلى آخر . الجدول الزمني الذي يحتوي على الإجراء يسمى الجدول الزمني للتحكم " the controlling timeline" ويسمى الجدول الزمني الذي يتلقى الإجراء الجدول الزمني الهدف"target timeline" . على سبيل المثال ، يمكن أن يكون هناك إجراء على الإطار الأخير من جدول زمني واحد يوضح جدول زمني آخر للعب . للإشارة إلى الجدول الزمني مستهدف ، يجب عليك استخدام مسار الهدف الذي يشير إلى موقع movie clip في قائمة العرض.
	يوضح المثال التالي التسلسل الهرمي لمستند يسمى westCoast على المستوى 0 والذي يحتوي على ثلاثة مقاطع movie clip : كاليفورنيا ، أوريغون ، وواشنطن . يحتوي كل مقطع من مقاطع الفيديو هذه بدوره على movie clip 
	كما هو الحال على ملقم ويب ، يمكن معالجة كل جدول زمني في Animate CC بطريقتين : 
	مع مسار مطلق أو مع مسار نسبي . 
	المسار المطلق للمثيل هو دائماً مسار كامل من اسم المستوى ، بغض النظر عن أي خط زمني يستدعيه الإجراء البرمجي . 
	- حدد المسارات المستهدفة "target paths" :
	للتحكم في مقطع movie clip أو تحميل ملف SWF أو زر button ، يجب تحديد مسار هدف . يمكنك تحديده يدوياً أو باستخدام مربع الحوار إدراج مسار الهدف أو بإنشاء تعبير يتم تقييمه إلى مسار مستهدف . لتحديد مسار الهدف لمقطع movie clip أو زر button  ، يجب تعيين اسم للمقطع و اسم للزر.
	لا يتطلب المستند الذي تم تحميله اسم نسخة ، لأنك تستخدم رقم المستوى الخاص به كاسم نسخة (على سبيل المثال، _level5).
	*الخطوات المتبعه لتحديد مسار الهدف ونوعه :
	  - قم بتعيين اسم نسخة إلى مقطع movie clip أو لزر button :
	1 - حدد مقطع أو زر فيلم على المسرح .
	2- أدخل اسم للشكل في مربع الخصائص المرتبطه به أو في المربع الظاهر أمامك بعد تحديده وضغط على F8.
	    - حدد مسار الهدف target path باستخدام مربع الحوار إدراج مسار الهدف :
	1- حدد مقطع movie clip أو الإطار frame أو الزر button الذي تريد تعيين الإجراء له.
	وهذا سيحدد رقم الفريم في الجدول الزمني له .
	2- في لوحة الإجراءات Actions panel (ويندو Window> Actions) ثم انتقل إلى مربع أدوات الإجراءات في الجانب الأيمن ، وحدد إجراء أو أسلوب يتطلب مساراً مستهدفاً . 
	3- انقر فوق مربع المعلمة أو الموقع في البرنامج النصي حيث تريد إدراج المسار الهدف .
	4- انقر فوق الزر إدراج مسار الهدف فوق جزء البرنامج النصي .
	5- حدد المسار المطلق أو النسبي لوضع المسار الهدف .
	6- حدد مقطع movie clip في قائمة عرض مسار المستهدف ، ثم انقر فوق موافق .
	كما في الصورة رقم (15) .
	- حدد مسار الهدف يدوياً :
	1- حدد مقطع movie clip أو الإطار frame أو الزر button الذي تريد تعيين الإجراء له.
	2- في لوحة الإجراءات (ويندو Window> Actions) انتقل إلى مربع أدوات الإجراءات في الجانب الأيمن ، وحدد إجراء أو أسلوب يتطلب مساراً مستهدفاً.
	3- أكتب النص البرمجي يدوياً في البرنامج النصي حيث تريد إدراج مسار الهدف .
	4 أدخل مسار الهدف المطلق أو النسبي في النص البرمجي .
	كما في الصورة رقم (16) .
	اليوم ، يستخدم برنامج Adobe Animate CC لغة  HTML5أكثر من ثلث المحتوى الذي تم إنشاؤه في فلاش " Flash Professional "  ، ليصل إلى أكثر من مليار جهاز في جميع أنحاء العالم . كما تم الاعتراف به كحل إعلان الذي يتوافق مع أحدث معايير مكتب الإعلانات التفاعلية (IAB)، ويستخدم على نطاق واسع في صناعة الرسوم المتحركة من قبل استوديوهات  “powerhouse studios like Nickelodeon and Titmouse Inc” .
	برنامج Adobe Animate CC يواصل دعمه لملفات الفلاش (SWF) و  (AIR).
	وبالإضافة إلى ذلك ، فإنه يمكن إخراج الرسوم المتحركة إلى أي شكل تقريباً (بما في ذلك SVG )، من خلال الهندسة المعمارية القابلة للتوسيع .
	وهناك أكثر بكثير من مجرد تغيير للاسم فقط . ففريق شركة الأدوبي تقوم دائماً على تحديث كبير مع ميزات جديدة لخلق الرسوم المتحركة لأي منصة في البرنامج .
	ويعتبر برنامج Adobe Animate CC من البرامج الأساسية التي يتم من خلالها بناء المحتويات التعليمية ، وذلك لما يقدمه من إمكانيات عالية في طريقة العرض الخاصة بالمحتويات التعليمية التفاعلية . لذلك كان هناك عمل متواصل كذلك من قبل الشركات المتخصصة في إنتاج المحتويات التعليمية من خلال هذا البرنامج . لذلك من الجميل تعلمه واستغلاله واستخدامه في إنتاج المحتويات التعليمية .
	1- كيف تصبح مصمم ألعاب / أعضاء فريق زاش / رابط الموقع http://xash.me/how-to-become-a-game-designer-infographic/ زاش مرخّص بموجب رخصة المشاع الإبداعي نَسب المُصنَّف - الترخيص بالمثل 4.0 دولي
	2- مدرسة w3schools لشرح لغات البرمجة / HTML5 Tutorial / Copyright 1999-2017 by Refsnes Data/ رابط الموقع https://www.w3schools.com/html/default.asp
	2- 334Bمدرسة w3schools لشرح لغات البرمجة / HTML5 Tutorial / Copyright 1999-2017 by Refsnes Data/ رابط الموقع https://www.w3schools.com/html/default.asp
	2- 334Bمدرسة w3schools لشرح لغات البرمجة / HTML5 Tutorial / Copyright 1999-2017 by Refsnes Data/ رابط الموقع https://www.w3schools.com/html/default.asp
	3- معلومات عن البرنامج  Introduction to Animate CC / Copyright © 2017 Adobe Systems Incorporated. All rights reserved / 
	رابط الموقع / https://helpx.adobe.com/animate/user-guide.html
	4- كتاب عن شرح البرنامج /من موقع Reading Books / adobe animate cc classroom in a book 2017 release the 10 project b / الكاتب Russell Chun  /ISBN10 : 0134665236 , ISBN13 : 9780134665238 / Page Number : 432
	رابط الموقع / http://epdf.me/adobe-animate-cc-classroom-in-a-book-2017-release-:-the-10-project-b/
	5- Adobe Animate CC First Look / © 2017 LinkedIn Corporation / Author Joseph Labrecque/ www.lynda.com
	رابط الموقع/https://www.lynda.com/Flash-Professional-tutorials/Adobe-Animate-CC-First-Look/471912-2.html
	6- What is Animate CC? / Copyright ©  Adobe Systems / ‎February‎ ‎8‎, ‎2016
	رابط الموضوع / https://helpx.adobe.com/animate/how-to/make-an-animation.html?set=animate--get-started--overview
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